
用户指南和产品规范

NI USB-9237
4 通道， 24 位，半桥 / 全桥模拟输入设备

本用户指南主要介绍 NI USB-9237 的使用方法和产品规范。NI USB-9237 为

24 位半桥 / 全桥模拟输入 4 通道提供 USB 接口。

说明

如图 1 所示， NI USB-9237 包含 2 个组件：NI 9237 模块和 NI USB-9162
外盒。

图 1 NI USB-9237 组件
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尺寸

图 2 为 NI USB-9237 设备的尺寸视图。

图 2 NI USB-9237 设备，以毫米 （英寸）为单位

安全守则

请遵循 NI USB-9237 的使用说明。

注 尽管 NI 9237 模块具有较高的认证标准，当它与 NI USB-9162 外盒配合使用时，系统

满足的标准受各组件限制。详细信息见产品规范。

高温表面 该符号表明组件表面温度较高。触摸该组件可能导致人员受伤。

注意 电源未断开或处于危险环境时，请勿断开 I/O 连线或连接器。

注意 电源未断开或处于危险环境时，请勿卸除模块。

注意 NI USB-9237 未通过用于危险环境的认证。

123.67 mm
(4.869 in.)

121.28 mm
(4.775 in.)

120.68 mm
(4.751 in.)

118.29 mm
(4.567 in.)

Hi-Speed USB Carrier
NI USB-9162

88.11 mm
(3.469 in.)

25.08 mm
(0.988 in.)
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相关文档

每套应用软件包和驱动程序都包括完成测量和控制测量设备的编程信息。

下列参考文档假定用户已安装 NI-DAQmx 8.7 或更高版本，如使用 NI 应用

软件，其版本应为 7.1 或更高。

用于 Windows 平台的 NI-DAQmx
DAQ 入门指南介绍在 Windows 平台安装 NI-DAQmx 和相应 DAQ 设备

的方法，以及判断设备工作状态的方法。点击开始 » 程序 »National 
Instruments»NI-DAQ»DAQ 入门指南查看文档。

NI-DAQ 自述文件中列出了此版本的 NI-DAQ 支持的设备信息。点击开始 »
程序 »National Instruments»NI-DAQ»NI-DAQ 自述文件查看文档。

NI-DAQmx 帮助介绍测量概念、NI-DAQmx 重要概念以及适用于所有编程

环境的常见应用程序。点击开始 » 程序 »National Instruments»NI-DAQ»
NI-DAQmx 帮助查看文档。

LabVIEW
新用户可通过 LabVIEW 入门指南熟悉 LabVIEW 图形化编程环境，掌握

LabVIEW 创建数据采集和仪器控制应用程序的基本特性。点击开始 »
程序 »National Instruments»LabVIEW»LabVIEW 帮助查看

LabVIEW 入门指南，或访问 labview\manuals路径下的

LV_Getting_Started.pdf。

在 LabVIEW 中点击帮助 » 搜索 LabVIEW 帮助，通过 LabVIEW 帮助熟悉

LabVIEW 编程理论、编程分步指导以及 VI、函数、选板、菜单和工具的相

关信息。关于 NI-DAQmx 的详细信息见 LabVIEW 帮助目录的下列主题：

• Labview 入门指南 »DAQ 入门指南－包括软件概述和使用 DAQ 助手

在 LabVIEW 中进行 NI-DAQmx 测量的教程。

• VI 和函数 » 测量 I/O VI 和函数－介绍 LabVIEW NI-DAQmx VI
和属性。

• 仪器测量－介绍在 LabVIEW 中采集和分析测量数据的概念及详解，

包括常见测量、测量基础、 NI-DAQmx 重要概念和设备信息。

LabWindows/CVI
LabWindows/CVI Help 中的 Data Acquisition 一章介绍了 NI-DAQmx
测量概念，其中 Taking an NI-DAQmx Measurement in 
LabWindows/CVI 主题包括使用 DAQ 助手创建测量任务的分步指导。

在 LabWindows™/CVI™ 中，点击 Help»Contents, 点击 Using 
LabWindows/CVI»Data Acquisition 查看文档。

LabWindows/CVI Help 中的 NI-DAQmx Library 一章包括 API 概述和

NI-DAQmx 函数参考信息。点击 LabWindows/CVI Help 中的 Library 
Reference»NI-DAQmx Library 查看文档。
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Measurement Studio
如在 Measurement Studio 中使用 Visual C++、 Visual C#、 Visual 
Basic .NET 对 NI-DAQmx 支持的设备编程，可在 MAX 中或 Visual 
Studio .NET 中打开 DAQ 助手，交互式地创建通道和任务。在

Measurement Studio 中，可根据任务或通道生成配置代码。关于生成代

码的详细信息，见 DAQ 助手帮助。也可在自定义应用程序中使用

NI-DAQmx API 创建通道和任务。

关于 NI-DAQmx 方法和属性的帮助，见 NI Measurement Studio Help
中的 NI-DAQmx .NET Class Library 或 NI-DAQmx Visual C++ 
Class Library。关于在 Measurement Studio 中编程的常见帮助，见

NI Measurement Studio Help，该帮助文件在 Microsoft Visual Studio 
.NET 帮助系统中。要在 Visual Studio .NET 下查看帮助文件，点击

Measurement Studio»NI Measurement Studio Help 查看文档。

按照下列步骤在 Visual C++、Visual C# 或 Visual Basic .NET 中创建应用

程序：

1. 在 Visual Studio .NET 中，点击 File»New»Project 打开“New 
Project”对话框。

2. 查找创建程序所在语言区域的 Measurement Studio 文件夹。

3. 选择一个项目类型。添加 DAQ 任务，作为步骤的一部分。

ANSI C，未安装 NI 应用软件
NI-DAQmx 帮助包括 API 概述和基本测量概念。点击开始 » 程序 »
National Instruments»NI-DAQ»NI-DAQmx 帮助查看文档。

NI-DAQmx C Reference Help 主要介绍 NI-DAQmx 库函数，可配合 NI
数据采集设备开发虚拟仪器、数据采集和设备控制应用程序。单击开始 »
所有程序 »NationalInstruments»NI-DAQ»NI-DAQmx C Reference 
Help。

.NET 语言，未安装 NI 应用软件
如已安装 Microsoft .NET Framework 1.1 或更高版本，可直接使用

Visual C# 和 Visual Basic .NET 平台上通过 NI-DAQmx 创建应用程序，

无需 Measurement Studio 支持。如要安装 API 说明文档，需安装

Microsoft Visual Studio .NET 2003 或 Microsoft Visual Studio 2005。

安装的说明文档包括 NI-DAQmx API 概述、测量任务和概念，以及函数参

考。该帮助文件完全集成在 Visual Studio .NET 文档中。通过开始 » 程序 »
National Instruments»NI-DAQ»NI-DAQmx .NET Reference Help
查看 NI-DAQmx .NET 文档。展开 NI Measurement Studio Help»
NI Measurement Studio .NET Class Library»Reference 可查看函数参

考信息。展开 NI Measurement Studio Help»NI Measurement Studio 
.NET Class Library»Using the Measurement Studio .NET Class 
Libraries 可查看 NI-DAQmx 与 Visual C# 和 Visual Basic .NET 配合使用

的相关主题。
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如需在 Visual Studio 中查看同一帮助主题，点击 Help»Contents，
从 Filtered By 下拉列表中选择 Measurement Studio，然后按照上述要

求操作。

设备文档和产品规范
NI-DAQmx 包括 Device Document Browser，其中包括 DAQ、 SCXI
和开关设备的在线文档 （例如，设备引脚说明、设备功能帮助文件及使用

说明）以及印刷版设备文档的 PDF 文件。插入光盘，使用 Device 
Document Browser 查找、阅读和 / 或打印设备文档。安装 Device 
Document Browser 后，单击开始 » 所有程序 »National Instruments»
NI-DAQ»Browse Device Documentation 查阅设备文档。

注 或者用户可通过 ni.com/manuals上下载这些文档。

培训课程
为满足客户使用 NI 产品开发应用程序时的帮助需求， NI 提供相应的培训课

程。请登录 ni.com/training，报名参加培训，获取详细课程资料。

网络技术支持
登录 ni.com/support或 zone.ni.com可获取更多技术支持。

软件安装

NI-DAQmx 为 NI USB-9237 提供适用于 Windows Vista/XP/2000
平台的驱动程序。用户可通过 DAQ 入门指南了解软件 / 硬件安装、通道和

任务配置的分步指导，以及应用程序开发入门。登录 ni.com/manuals可

下载文档。

安装其他软件
如需使用其他软件，见软件随附安装说明。

程序范例
NI-DAQmx 光盘中带有程序范例，用户可使用这些程序范例尝试对

NI USB-9237 编程。相关信息见设备随附的 NI-DAQmx 在 USB 设备上的应

用－入门指南，或通过开始 » 所有程序 »National Instruments»NI-DAQ
查看文档。
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安装 NI USB-9237 设备

安装硬件设备前，需安装设备所需软件。详细信息见文档软件安装部分及软

件相关文档。

在 USB-9162 外盒内安装 NI 9237
NI 9237 模块和 USB-9162 外盒均为独立包装。请参照图 3 完成下列安装步

骤：

1. 确保 NI 9237 模块未连接信号或 USB 线缆。

2. 移开 15 针 D-SUB 连接器的保护盖。

3. 如图 3 所示，对齐 I/O 模块和机箱。

图 3 模块安装

4. 挤压卡锁，将 NI 9237 模块插入 USB-9162 外盒。

5. 如图 4 所示，用力按压 NI 9237 模块与外盒的连接部分，直至模块固

定到位。

图 4 锁定模块
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固定 NI USB-9237 至面板
NI USB-9237 表面带有内嵌螺纹孔，用于设备与面板间固定。图 5 为尺寸视

图。

图 5 模块尺寸，以毫米 （英寸）为单位

连接 NI USB-9237 至计算机
USB 线缆一端连接 NI USB-9237，另一端连接计算机可用 USB 端口。详细

信息见设备随附的 NI-DAQmx 在 USB 设备上的应用－入门指南，或通过

开始 » 程序 »National Instruments»NI-DAQ 查看该文档。

LED 指示灯
NI USB-9237 设备在靠近 USB 端口处带有一个绿色 LED 指示灯。如表 1 所

示， LED 指示灯用于显示设备状态。设备连至 USB 端口时， LED 指示灯将

有节奏的闪烁。表明设备正在初始化且 USB 端口为设备供电。

如 LED 指示灯未闪烁，表明设备未进行初始化或计算机处于待机模式。设

备连接的计算机应预装 NI-DAQmx 软件，以确保设备可被识别。设备指示

灯未闪烁的情况下，请确认计算机已安装最新版本的 NI-DAQmx，且计算

机未处于待机模式。

 

72.2 mm
(2.84 in.)

85.7 mm
(3.37 in.)

76.1 mm
(3.00 in.)

螺纹旋入点
M3 x 0.5
8.5 mm (0.34 in.) 最大深度
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连接 NI USB-9237 设备

NI USB-9237 有四个 RJ-50 插座，可提供四个半桥或全桥连接。表 2 为每

个连接器端子的信号名称，以及 RJ-50 10 孔 /10 导线 (10p10c) 模块插头

的引脚编号与 NI USB-9237 插座的对应关系。NI USB-9237 还带有一个四孔

连接器，用于连接外部激励电压源至模块。表 2 为外部激励电压源与

NI USB-9237 的连接示意图。

注 关于 NI USB-9237 的可用附件列表，请访问 ni.com/info，输入信息代码 rd9237

查询。

表 1 LED 状态 / 设备状态

LED 状态 设备状态

不亮 未连接设备或计算机处于暂停模式。

亮，不闪烁 设备已连接，未安装模块。

单闪 正常工作。

双闪 连至 USB 全速端口。设备性能可能受到影响。详细
信息见产品规范。

闪烁 4 次 设备出错。请访问 ni.com/support获取帮助。
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注意 NI 不建议将 RJ-45 与 NI USB-9237 配合使用，因为可能会对引脚 1 和引脚 10 造成

物理损害，进而造成无论使用何种连接器均无法进行分流校准，导致分流校准功能的永久

性损坏。

表 2 端子说明

RJ-50 (10p10c) 模
块插头和插座的引

脚编号 RJ-50 引脚 RJ-45 引脚 信号名称 信号说明

1 — SC 分流校准

2 1 AI+ 正输入信号

3 2 AI– 负输入信号

4 3 RS+ 正负载端电压采样信号

5 4 RS– 负负载端电压采样信号

6 5 EX+ 正激励信号 *

7 6 EX– 负激励信号 *

8 7 T+ TEDS 数据

9 8 T– TEDS 返回 *

10 — SC 分流校准

* NI USB-9237 的 4 个 RJ-50 连接器均可连接上述信号。
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图 6 四孔外部激励电压源连接

连接负载至 NI USB-9237
图 7 为连接半桥或全桥至 NI USB-9237 的示意图。

图 7 半桥和全桥连接

注 通过添加外部电阻创建半桥，或使用 NI 9944/NI 9945 1/4 桥电阻附件将

NI USB-9237 与 1/4 桥配合使用。关于 NI 9944 和 / 或 NI 9945 1/4 电阻附件及购买附件

的详细信息，请访问 ni.com。

1 EX– 2 EX+ 3 EX+ 4 EX–

1 虚线表示全桥为可选的，半桥为必需的。 2 仅图中四个信号为必须连接的信号。

2

1

4

3

EX+

EX–

SC
SC

RS+

RS–

T+

T–

AI–*
AI+

TEDS
连接半桥至NI USB-9237时，AI– 信号
为未连接状态。

*

21
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连接 TEDS 通道
确保 TEDS 数据 (T+) 和 TEDS 返回 (T–) 与 NI USB-9237 的任何 AI 信号均无

公共连接。关于 TEDS 传感器的详细信息，请访问 ni.com/info，输入信

息代码 rdteds查询。

NI USB-9237 连接选项
导线电阻可引起桥电路误差。NI USB-9237 提供两种消除误差的机制：负载

端电压采样和分流校准。

负载端电压采样
负载端电压采样可自动连续的校正激励导线误差，通常全桥和半桥传感器选

用此机制。

较长的导线和短的粗导线具有较大的电阻，可引起增益误差。激励电压至电

桥的电阻所产生的电压降可能导致增益误差。

NI USB-9237 通过负载端电压采样补偿此误差。负载端电压采样导线被连接

至激励电压与桥电路相接的位置。

图 8 为 NI USB-9237 使用负载端电压采样的示意图。

图 8 负载端电压采样误差补偿

如图 8 所示，实际电桥激励电压低于 EX+ 和 EX– 两端的电压。如未使用实

际桥电压的负载端电压采样，所导致的增益误差为

全桥传感器和

半桥传感器误差。

EX +

EX –

RS +

RS –

AI –AI +

Rbridge

Rbridge

Rbridge

Rbridge

Rlead

Rlead

2Rlead

Rbridge
----------------

Rl ead
Rbr i dge
----------------
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如负载端电压采样 (RS) 信号直接与桥电阻连接， NI USB-9237 采样为实际

电桥电压移除 EX+ 和 EX– 导线电阻产生的增益误差后的值。

分流校准
分流校准可校正导线电阻产生的误差，此处的导线是指连接激励电压和各电

桥电阻的导线。分流校准机制尤其适用于 1/4 桥传感器，因为连接至电桥

的导线可能具有较大阻值。

NI USB-9237 分流校准电路由一个高精度 100 kΩ 电阻和一个软件控制开关

组成。分流校准端子与传感器保持连接的情况下，可通过软件应用或移除分

流校准电阻。

负载端电压采样可校正 NI USB-9237 的 EX 端子至传感器的电阻产生的误

差，分流校准除校正此误差外，还可校准电桥桥臂导线电阻产生的误差。

分流校准通过将电桥桥臂的阻值改变为某已知的值来模拟应变输入。即通过

分流 （在电桥某一桥臂上连接一个较大的已知阻值的电阻）和创建已知的

电阻应变实现。随即测量电桥的输出值，并将其与预期的电压值进行比较。

该结果用于校正整个测量通道中的增益误差，或用于在设置过程中检测常规

操作。

稳定信号通常是指传感器的未加载状态，首先在关闭分流校准的状态下使用

该信号，然后开启分流校准，再次应用该信号。通过两次测量的差值可了解

增益误差与导线电阻的关系。并设计软件程序校正此增益误差读数。

激励电压
虽然传感器行业至今仍没有关于激励电压的统一标准，但是激励电压通常位

于 2.5 V ～ 10 V 范围内。用户可通过编程使 NI USB-9237 提供 2.5 V、

3.3 V、5 V 或 10 V 激励电压，模块可提供的最大激励功率为 150 mW。在

未提供外部激励电压的情况下， NI 建议将激励电压设置为可保证总功率低

于 150 mW 的值。 NI USB-9237 会自动降低内部激励电压，以保持功率小

于 150 mW。

单个电桥的功率为

其中， R 为该电桥的总阻值。

对于全桥，R 等于每个组成部分的阻值。对于 1/4 桥或半桥，R 等于每个组

成部分电阻阻值的两倍。

Vex
2

R
---------
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在不超出 150 mW 功率限制的情况下，可进行下列全桥和半桥功率分配：

• 4 个 350 Ω 半桥， 5.0 V

• 4 个 350 Ω 全桥， 3.3 V

• 4 个 120 Ω 半桥， 2.5 V

如需激励电压产生大于 150 mW 的功率，可使用四孔外部激励电压连接器

将外部激励源连接至 NI USB-9237。图 6 为四孔外部激励电压连接器及其引

脚说明。

NI USB-9237 电路

NI USB-9237 与地面隔离。但各通道间不隔离。在各通道间， EX+、 EX– 和

T– 信号均为共模信号。 NI USB-9237 可连接偏置电压位于 NI USB-9237 共

模抑制电压范围内的设备。详细信息见产品规范。

NI USB-9237 也可连接浮接信号，此时 NI 建议将 EX– 信号接地或屏蔽，

以获得更好的噪声抑制。

NI USB-9237 上的每条通道都带有独立的 24 位模数转换器和输入放大器，

可同步采集四路通道上的信号。

NI USB-9237 带有防混叠滤波器。 NI USB-9237 的滤波器根据采样率滤波。

NI USB-9237 的滤波
通过使用模拟和数字滤波，NI USB-9237 可精确表示带内信号并抑制带外信

号。滤波器根据信号的频率范围 （带宽）区分信号。三个需考虑的重要带

宽因素分别为：通带、阻带和无混叠带宽。

NI USB-9237 主要通过通带平滑度和相位非线性度定量表示通带内信号。滤

波器可最大程度的抑制阻带内频率，即阻带抑制。无混叠带宽范围内的所有

信号均为无混叠信号或至少经阻带抑制过滤的信号。

通带
通带内信号的增益和衰减是基于频率变化的。通带平坦度是指相对于某频率

范围，增益的变化幅度非常小。NI USB-9237 的滤波器通过调整通带的频率

范围 , 使其与采样率匹配。因此，给定频率下的增益和衰减取决于采样率。

图 9 为某采样率范围下的典型通带平坦度。
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图 9 典型通带响应

阻带
滤波器将显著减弱所有高于阻带频率的信号。主要目的是防止产生混叠。因

此，阻带频率与采样率之间存在精确的比例关系。阻带抑制是滤波器对阻带

内所有可能混叠至无混叠频率带宽内的频率信号应用的最小衰减值。

无混叠带宽
NI USB-9237 无混叠带宽中不包含任何带外混叠失真信号。无混叠带宽是由

滤波器抑制高于阻带频率信号的能力定义的，无混叠带宽等于采样率减去阻

带频率。

产品规范

除非另外声明，否则下列规范的适用温度范围为 0 ～ 60 °C。

输入特性
通道数 ................................................................. 4

电桥电阻

全桥和半桥................................................  内部

1/4 桥 .........................................................  外接

ADC 分辨率...................................................... 24 位

ADC 类型 ..........................................................Delta-Sigma （带模拟预滤波）

采样模式.............................................................  同步

采样率 (fs ) ......................................................... ， n = 1， 2， ……31

 

频率/采样率 (kHz)
10.8

0.025

0.000

–0.025

–0.050
0.60.40.20

增
益
 (

dB
)

50000 kS/s
n

----------------------------
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主时基 （内部）

频率 ............................................................ 12.8 MHz
精度 ............................................................  ± 100 ppm，最大值

额定全量程范围 ...............................................  ± 25 mV/V

转换精度 ............................................................ 2.9802 nV/V/LSB

过压保护
任意端子间 ........................................................ ± 30 V

精度

增益漂移 ............................................................ 10 ppm/°C，最大值

电压漂移

2.5 V 激励................................................. 0.6 μV/V/°C

3.3 V 激励................................................. 0.5 μV/V/°C

5 V 激励 .................................................... 0.3 μV/V/°C

10 V 激励.................................................. 0.2 mV/V/°C

通道匹配 （已校准）

相位非线性

0 ～ 1 kHz................................................. <0.001°
0 ～ 20 kHz ..............................................  ± 0.1°

输入延迟 ............................................................ 4.8 μs + 38.4/fs

误差 *
读数百分比

（增益误差）

量程百分比

（偏置误差）†

已校准，最大值 (0 ～ 60 °C) 0.20% 0.25%

已校准，常规值 (25 °C, ±5 °C) 0.05% 0.05%

未校准，最大值 (0 ～ 60 °C) 0.60% 0.35%

未校准，常规值 (25 °C, ±5 °C) 0.20 0.1%

* 不包含偏移归零和分流校准。

† 范围大小等于 25 mV/V。

输入信号频率 (fin)

增益 相位

常规值 最大值 最大值

0 ～ 1 kHz 0.15% 0.3% 0.125°/kHz · fin*

1 ～ 20 kHz 0.4% 1.1%

* fin 以 kHz 为单位。
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通带

频率............................................................. 0.45 · fs
平坦度 ........................................................ 0.1 dB，最大值

阻带

频率............................................................. 0.55 · fs
抑制............................................................. 100 dB

无混叠带宽 ........................................................ 0.45 · fs

过采样率............................................................. 64 · fs
过采样率时的抑制1

50 kS/s..............................................  90 dB, 3.2 MHz
10 kS/s..............................................  60 dB, 640 kHz

共模电压

所有接地信号 ...........................................  ± 60 VDC

共模抑制比 (CMRR)
对地2 ........................................................... 140 dB, 0 ～ 60 Hz
对 EX–......................................................... 85 dB, 0 ～ 1 kH

输入噪声

无杂波动态
范围 (SFDR) ...................................................... 106 dB, (1 KHz, –60 dBFS)

总谐波失真 （基本， –20 dBFS）
1 kHz .......................................................... 100 dB
8 kHz .......................................................... 90 dB

激励噪声............................................................. 0.1 mV/Vrms

串扰

1 kHz .......................................................... 110 dB
10 kHz........................................................ 100 dB

1   模拟预滤波器在过采样率上对信号频率的抑制。
2   应使用平衡电缆测量。屏蔽电缆的平衡性较差。

激励电压

密度 
(nV/Vrms/

)

全频段
(50 kS/S) 
(μV/Vrms)

0 ～ 1 kHz 
(nV/Vrms)

2.5 V 8 1.3 250

3.3 V 6 1.0 190

5 V 4 0.6 130

10 V 2 0.3 65

1H z
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分流校准

电阻 ............................................................ 100 kΩ
电阻精度

25 °C.................................................  ± 110 Ω
0 ～ 60 °C .......................................  ± 200 Ω

激励

内部激励电压........................................... 2.5 V, 3.3 V, 5.0 V, 10.0 V
内部功率.................................................... 150 mW ，最大值

外部激励电压........................................... 2 V ～ 10 V

电源要求
USB 电流消耗 ................................................... 500 mA，最大值

暂停模式.................................................... 2.5 mA，最大值

总线接口
USB 规范 ............................................................ USB 2.0 高速

物理特性
尺寸 ..................................................................... 12.1 cm × 8.6 cm × 2.5 cm 

(4.75 in. × 3.37 in. × 0.99 in.)

重量 .....................................................................  约 250 g (8.8 oz)

安全性
请使用干毛巾清洁模块。

安全电压
仅连接规定范围之内的电压。

任意端子间 ........................................................  ± 30 V，最大值

隔离

通道－通道 ...............................................  通道间无隔离

通道－地

连续性 ............................................... 60 VDC, Measurement 
Category I

耐压性 ............................................... 1000 Vrms，经 5 秒介电耐压测试

Measurement Category I 是指测量与配电系统非直接相连 （MAINS 电

压）的电路。 MAINS 是指为设备提供电力的危险带电供电系统。该类别用

于测量受特殊保护的二级电路的电压。这类电压测量包括对信号电平、特殊

设备、设备能量有限制的部件、由低稳压源供电的电路，以及电子设备的测

量。在 Measurement Categories II, III 和 IV 中，请勿使用 NI USB-9237
连接信号或进行测量。
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安全标准
NI USB-9237 的设计符合以下测量、控制和实验室用途的电气设备安全标

准。

• IEC 61010-1, EN 61010-1

• UL 61010-1, CSA 612010-1

注 关于 UL 和其它安全认证信息，请查看产品标签或访问 ni.com/certification，

通过模块编号或产品类型搜索，并在“ 认证” 栏中查看相应链接。

危险环境
NI USB-9237 未通过用于危险环境的认证。

环境
通常 NI USB-9237 设备只适用于室内。

运行环境温度

(IEC 60068-2-1, IEC 60068-2-2) ............... 0 ～ 60 °C

存储温度

(IEC 60068-2-1, IEC 60068-2-2).................. –40 °C ～ 85 °C

防护等级............................................................. IP 40

运行环境湿度 (IEC 60068-2-56) ................ 10 ～ 90% RH，无凝结

存储湿度 (IEC 60068-2-56) ......................... 5 ～ 95% RH，无凝结

最高海拔............................................................. 2000 m

污染等级 (IEC 60664) ................................... 2

电磁兼容性
产品设计符合以下测量、控制和实验室用途的 EMC 标准。

• EN 61326 EMC ；最小抗扰度

• EN 55011 放射标准； Group 1 （非蓄意放射） , Class A （不使用于

住宅区）

• CE, C-Tick, ICES 和 FCC Part 15 放射标准； Class A

注 依据 EMC 规范，设备应使用双屏蔽电缆。
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CE 合规声明
产品已达到现行欧盟产品规范的基本要求，并附有 CE 标志。如下所示：

• 2006/95/EC ；低电压规范 （安全性）

• 2004/108/EC ；电磁兼容标准 (EMC)

注 如需更多常规性标准信息，请查阅本产品的合规声明。获取本产品合规声明，请访问

ni.com/certification，搜索型号或产品线并在认证栏目中查询相应链接。

环境保护
NI 始终致力于设计和制造有助于环境保护的产品。 NI 认为减少产品中的有

害物质不仅有益于环境，也有利于 NI 客户。

关于环境保护的详细信息，请登录 ni.com/environment，查看 NI and 
the Environment 页面。该页包含 NI 遵守的环境准则和规范，以及本文档

未涉及的其他环境信息。

电子电器设备废弃物 (WEEE)
欧盟用户  超过生命周期的所有产品都必须送到 WEEE 回收中心。关于 WEEE 回收中心及

NI WEEE 项目，请访问 ni.com/environment/weee.htm。

校准
访问 ni.com/calibration可获取 NI USB-9237 的校准认证。

校准周期 ............................................................ 1 年

RoHS
National Instruments  (RoHS)

National Instruments RoHS ni.com/environment/rohs_china
(For information about China RoHS compliance, go to ni.com/environment/rohs_china.)
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技术支持

NI 网站可提供全面的技术支持资源。访问 ni.com/support，您可获取疑

难解答、应用程序开发自助资源，以及来自 NI 应用工程师的电话或电子邮

件帮助。

NI 总部地址：11500 North Mopac Expressway, Austin, Texas, 
78759-3504。 NI 在全球设立的分支机构也将为您提供技术支持。在美国，

可访问 ni.com/support提交服务请求并按要求进行操作，或拨打电话

512 795 8248 获取技术支持。在其它国家或地区，可联系当地办事处获取

技术支持。您也可以访问全球办事处 ni.com/niglobal，查找最新的办事

处联系方式、技术支持电话、电子邮件地址及最新消息。


	NI USB-9237 用户指南和产品规范
	说明
	图 1 NI USB-9237 组件

	尺寸
	图 2 NI USB-9237 设备，以毫米（英寸）为单位

	安全守则
	相关文档
	用于 Windows 平台的 NI-DAQmx
	LabVIEW
	LabWindows/CVI
	Measurement Studio
	ANSI C，未安装NI应用软件
	.NET语言，未安装NI应用软件
	设备文档和产品规范
	培训课程
	网络技术支持

	软件安装
	安装其他软件
	程序范例

	安装 NI USB-9237 设备
	在 USB-916 2外盒内安装 NI 9237
	图 3 模块安装
	图 4 锁定模块

	固定 NI USB-9237 至面板
	图 5 模块尺寸，以毫米（英寸）为单位

	连接 NI USB-9237 至计算机
	LED 指示灯
	表1 LED 状态/设备状态


	连接 NI USB-9237 设备
	表2 端子说明
	图 6 四孔外部激励电压源连接
	连接负载至 NI USB-9237
	图 7 半桥和全桥连接

	连接 TEDS 通道
	NI USB-9237 连接选项
	负载端电压采样
	图 8 负载端电压采样误差补偿
	分流校准

	激励电压

	NI USB-9237 电路
	NI USB-9237 的滤波
	通带
	图 9 典型通带响应
	阻带
	无混叠带宽


	产品规范
	输入特性
	电源要求
	总线接口
	物理特性
	安全性
	安全电压
	安全标准
	危险环境

	环境
	电磁兼容性
	CE 合规声明
	环境保护
	校准

	技术支持



